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WHERE ARE THE LESSON FILES?
Purchase of this Classroom in a Book in any format gives you access to the lesson files you’ll 
need to complete the exercises in the book.

1 Go to www.adobepress.com/LightroomCIB2022.

2  Sign in or create a new account.

3  Click Submit.

4  Answer the questions as proof of purchase.

5  The lesson files can be accessed through the Registered Products tab on your Account page.

6   Click the Access Bonus Content link below the title of your product to proceed to the 
download page. Click the lesson file links to download them to your computer.

P N ot e:  If you encounter 
problems registering your 
product or accessing the 
lesson files or web edition, go 
to www.adobepress.com/ 
support for assistance.

P N ot e:  If you purchased 
a digital product directly 
from adobepress.com or 
peachpit.com, your product 
will already be registered. 
However, you still need to 
follow the registration steps 
and answer the proof of 
purchase question before 
the Access Bonus Content 
link will appear under the 
product on your Registered 
Products tab.
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PHOTOGRAPHY SHOWCASE

BINUK VARGHESE

“Photography is the universal language of this era.” 

I am a travel photographer based in Dubai, but hailing from Kerala, India. My passion  
is traveling around the globe, experiencing its unique cultures and scenic beauty. One  
of the best things about being a travel photographer is connecting with people and 
learning about their habitats and lifestyles.

My recent project, Life in Frames, includes some of my personal favorite portraits of 
people taken on my journeys. Each portrait depicts a different character and silently 
echoes their story. I try to reflect real life and its emotions through my photographs, 
exploring the unexplored and sharing the unseen. I push myself to capture that moment 
of magic, that glimpse of time that gives an insightful perspective or that is visually sub-
lime. As you can see through my photographs, I love to keep things simple in life.

Photography is the universal language of this era, and my work tells a variety of tales 
in this language. My photographs reexamine and redefine the moments I capture. 
Photography has become the oxygen of my life, which helps me keep moving forward.

I use Lightroom extensively for cataloging my files and maintaining a library of images, 
enabling me to deliver my work faster. 

I intend to continue nurturing, encouraging, cajoling, appreciating, and celebrating 
photo stories.

instagram.com/binuk.varghese/

http://instagram.com/binuk.varghese/
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2 BRINGING PHOTOS INTO 
LIGHTROOM CLASSIC

Lesson overview
Lightroom Classic allows a great deal of flexibility when importing 
photos: you can download them directly from a camera, import them 
from an external drive, or transfer them between catalogs on separate 
computers. During the import process, you can organize folders, add 
keywords and metadata to make your photos easier to find, make 
backup copies, and even apply editing presets. In this lesson, you’ll 
learn how to:

•  Import images from a camera or card reader.

•  Import images from a hard disk or removable media.

•  Evaluate images before importing.

•  Organize, rename, and process images automatically.

•  Implement a backup strategy.

•  Set up automatic importing and create import presets.

•  Acquire images from other catalogs and applications.

This lesson will take about 1 to 2 hours to complete. To get the lesson 
files used in this chapter, download them from the web page for this 
book at adobepress.com/LightroomCIB2022. For more information, see 
“Accessing the lesson files and Web Edition” in the Getting Started section 
at the beginning of this book.

http://adobepress.com/LightroomCIB2022
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Lightroom Classic helps you to begin organizing 
and managing your growing photo library. From the 
moment you click the Import button; you can make 
backups, create and organize folders, inspect images 
at high magnifi cation, and add keywords and other 
metadata that will save you hours of sorting and 
searching your image library later—and all this 
before your photos even reach your catalog! 
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Getting started
Before you begin, make sure you’ve set up the LRC2022CIB folder for your lesson 
files and downloaded the lesson02 folder from your Account page at peachpit.com 
to the LRC2022CIB\Lessons folder, as described in “Accessing the lesson files and 
Web Edition” in the “Getting Started” section at the start of this book. Also, be sure 
you have created the LRC2022CIB Catalog file to manage the lesson files, as detailed 
in “Creating a catalog file for working with this book,” also in the “Getting Started” 
section.

1 Start Lightroom Classic. In the Select Catalog dialog box, make sure that 
LRC2022CIB Catalog.lrcat is selected, and then click Open.

2  Lightroom Classic will open in the screen mode and workspace module  
that were active when you last quit. If necessary, switch to the Library module  
by clicking Library in the Module Picker at the top of the workspace.

Lightroom is your digital notebook
Before we begin, I want to share with you an analogy that I think helps explain what 
Lightroom does in terms of organization. I’ll come back to this analogy from time to 
time throughout the book.

Imagine you are sitting at home when someone knocks on the door and gives you  
a box of pictures. They ask you to store the pictures for safekeeping, so you take the 
box into your home and place it on top of your desk in the living room. In order to 

E Tip: If you can’t 
see the Module Picker, 
choose Window > 
Panels > Show Module 
Picker, or press the F5 
key. If you’re working 
on macOS, you may 
need to press the fn 
key together with the 
F5 key, or change the 
function key behavior in 
the system preferences.

http://peachpit.com
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remember where you placed those pictures, you pull out a notebook and write down 
that they are in a box on the desk in the living room.

There’s another knock at the door, and another box of pictures appears. You take 
these pictures and place them inside one of the drawers in your bedroom. You want 
to remember where they are, so you write it down in your notebook. More boxes 
of pictures appear, and you continue to place them in different areas of your house, 
writing down the location of each box of pictures in your notebook—there are a lot 
of boxes of pictures, and you don’t want to forget! 

That notebook becomes the central record of where the boxes of pictures are stored 
in your home.

Now, imagine that you’re bored one day while at home, and you take the pictures 
that are in the box on top of the desk in the living room and place them in a par-
ticular order. You want to make a note of this change, so you write down in your 
notebook that the pictures on top of the desk in the living room have been orga-
nized in a specific fashion.

The notebook you’ve been using serves as the master record of the location of each 
box of pictures inside your home, as well as a record of all of the changes you’ve 
made to each picture.

That notebook is your Lightroom catalog—your Lightroom catalog is a digital note-
book that keeps track of where your images are and what you have done to them.

Lightroom doesn’t store your images; it stores information about your images in 
the catalog. This catalog includes a ton of information about each image (or video), 
including where the file lives on your drives; the camera settings at capture; any 
descriptions, keywords, ratings, and so on, that you apply in Lightroom’s Library 
module; and a running list of every edit you make in Lightroom’s Develop module.

When you think of your Lightroom catalog, just think of a digital notebook that’s 
keeping track of where you put your pictures and what you are doing with them.

The import process
Lightroom Classic has a number of options for importing your images. You can 
import directly from a digital camera or card reader, your hard disk, or any external 
storage media, or you can transfer them from another Lightroom catalog or from 
other applications. You can import at the click of a button, use a menu command, 
or simply drag and drop. Lightroom can launch the import process as soon as you 
connect your camera, or import automatically whenever you move files into a speci-
fied folder. Wherever you’re acquiring photos from, it will be important to become 
familiar with the Import dialog box.
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The top section of the Import dialog box presents the basic steps in the import pro-
cess, arranged from left to right: choose an import source, specify how Lightroom 
is to handle the files you’re importing, and then—if you choose to copy or move 
the source files—set up an import destination. If these are all of the details that you 
require to import the images, you can leave the dialog box set to compact mode. To 
access even more information, you can click the triangle at the lower left to expand 
to the full dialog box.

In expanded mode, the Import dialog box looks and works like the Lightroom 
Classic workspace modules. The Source panel at the left accesses your files on any 
available drive. The Preview area in the center displays images from the source 
as thumbnails in Grid view or enlarged in Loupe view. Depending on the type of 
import, the right panel group offers a Destination panel that mirrors the Source 
panel, and a set of controls for processing your images while they’re being imported.
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Importing photos from a digital camera
While this next section outlines the process of importing from a camera pretty 
clearly, I recommend that you try this with some sample images of your own. Take 
your camera and make 10–15 images of anything, really, just have something on  
the memory card that we can use for the import process.

The first step is to ensure the Lightroom preferences are set so that the import 
process is triggered automatically whenever you connect your camera or a memory 
card to your computer.

1 Choose Lightroom Classic > Preferences (macOS)/Edit > Preferences (Windows). 
In the Preferences dialog box, click the General tab. Under Import Options, 
select Show Import Dialog When A Memory Card Is Detected.

Some cameras generate folder names on the memory card. If you don’t find these 
folder names helpful for organizing your images, select Ignore Camera-Generated 
Folder Names When Naming Folders. You’ll learn more about folder naming 
options later in this lesson.

2  Click the Close button or OK to close the Preferences dialog box.

3  Connect your digital camera or card reader to your computer, following the 
manufacturer’s instructions.

4  This step may vary depending on your operating system and the image manage-
ment software on your computer:

•  In Windows, if the AutoPlay dialog box or settings pane appears, select the 
option to open image files in Lightroom Classic. If you wish, you can set this 
option as the default.

•  If you have more than one Adobe image management application—such 
as Adobe Bridge—installed on your computer and the Adobe Downloader 
dialog box appears, click Cancel.

•  If the Import dialog box appears, continue to step 5.
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•  If the Import dialog box does not appear, choose File > Import Photos And 
Video, or click the Import button below the left panel group.

5  If the Import dialog box appears in compact mode, click the Show More Options 
button at the lower left of the dialog box to see all of the options in the expanded 
Import dialog box.

The top panel of the Import dialog box—visible in both the compact and expanded 
modes—presents three steps in the import process, arranged from left to right:

•  Selecting the source location of the images you wish to add to your catalog.

•  Specifying how you want Lightroom to handle the files you’re importing.

•  Setting the destination to which the image files will be copied, with the option 
to choose any develop presets, keywords, or other metadata that you would like 
applied to your photos as they are added to your catalog below this panel.

 y

Your camera or memory card is now shown as  
the import source in the FROM area at the left 
of the top panel and under Devices in the Source 
panel at the left of the Import dialog box.

Depending on your computer setup, it’s possible 
that your camera’s memory card will be recog-
nized as a removable storage disk. If this is the 
case, you may see some differences in the options 
available in the Import dialog box, but it shouldn’t 
affect anything.

6  If your memory card is listed as a removable 
disk—rather than a device—in the Source 
panel, click to select it from the Files list and 
make sure that Include Subfolders is selected.

7  From the import type options in the center of 
the top panel, choose Copy, so that the photos 
are copied from your camera to your hard disk 
and then added to your catalog, leaving the 
original files on your camera’s memory card.

P Note: If your mem-
ory card is recognized 
as a removable disk, the 
Move and Add options 
may not be disabled as 
illustrated here and on 
the next page; these 
import options are 
discussed later in this 
lesson.
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Lightroom displays a brief description of the action that will be taken for whichever 
option is currently selected.

8  Move your pointer over each of the options shown in the bar across the top of 
the Preview pane to see a tool tip describing the option. For this exercise, leave 
the default All Photos option selected and don’t click the Import button yet.

A checkmark in the upper-left corner of an image cell indicates that the photo will 
be imported. By default, all of the photos on your memory card will be selected for 
import. If you do not want to import an image, you can exclude it by clicking its 
checkbox to deselect it.

You can select multiple images and then change all of their checkmarks simultane-
ously. To select a contiguous range of images, select the first image in the range by 
clicking the thumbnail or the surrounding image cell, and then hold down the Shift 
key and select the last image in the series. To select individual additional images, 
Command-click/Ctrl-click their thumbnails. Click the checkmark of any selected 
image to change the import status for the entire selection.

E Tip: Use the slider 
below the preview pane 
to change the size of 
the thumbnails.
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Notice that at the top of the import dialog, Copy is selected rather than Add. Keep 
in mind that, during the import process, Lightroom does not actually import the 
image files themselves; it only adds entries to the Lightroom catalog to record their 
locations. Because you’re copying the files, you’ll need to specify a destination.

If you selected Add rather than Copy, you wouldn’t have to specify a destination 
folder; the photos would stay where they are already stored. However, because 
memory cards are expected to be erased and reused, they should not be the 
permanent home for your pictures. Thus, you’re not offered the Add and Move 
options when you import from a camera—Lightroom expects to copy your photos 
from your memory card to a more permanent location.

The next step, then, is to specify a destination folder to which your photos should  
be copied. This is the time to give some thought to how you intend to organize  
your photos on your hard drive. For now, leave the Import Photos dialog box open; 
you’ll choose a destination folder and deal with the rest of the import options in  
the following exercises.

Organizing your copied photos in folders
By default, Lightroom tries to organize your images in the Pictures folder. You can 
choose any other location, but as a general rule, it is a good idea to keep all of your 
images organized into one location—no matter where that is. Nailing down that 
location (or workflow) early will help a ton in finding missing images (we’ll talk 
about the workflow later in the book).

Before beginning the lessons in this book, you created a folder named LRC2022CIB 
inside your Users/use r n a m e /Documents folder on your computer. This folder already 
contains subfolders for your LRC2022CIB Catalog file and for the image files used 
for the lessons in this book. For the purposes of this exercise, you’ll create another 
subfolder inside the LRC2022CIB folder as the destination for the images that you 
import from your camera’s memory card:

1 In the right panel group of the Import dialog box, 
collapse the File Handling, File Renaming, and 
Apply During Import panels; then, expand the 
Destination panel.

2  In the Destination panel, navigate to and select 
your LRC2022CIB folder; then, click the plus  
sign (+) button at the left of the Destination 
panel header and choose Create New Folder 
from the menu.

3  In the Browse For Folder/Create New Folder 
dialog box, navigate to and select your 
LRC2022CIB folder, if it’s not already selected. 
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Click the New Folder button, type Imported From Camera as the name for your 
new folder, and then click Create (macOS) or press Enter (Windows).

4  Make sure the new Imported From Camera folder is selected in the Browse For 
Folder/Create New Folder dialog box, and then click the Choose/Select Folder 
button to close the dialog box. Note that the new folder is now listed and 
selected in the Destination panel.

The name of the new destination folder also  
appears in the TO area at the right of the top  
panel of the Import dialog box.

The Organize menu, near the top of the Destination panel, offers various options to 
help you organize your photos into folders as you copy them onto your hard disk:

•  Into One Folder With the current settings, the images would be copied into  
the new Imported From Camera folder. Instead, you could select Into Subfolder 
to create a new subfolder for each import from your camera.

•  By Date: [Date Format] These options are all  
variations on organizing your photos by capture 
date. Your images would be copied into one or  
more subfolders, depending on your choice of  
date format. Choosing the format “2021/10/03” 
for example, would result in one folder per year, 
containing one folder per month, containing one 
folder per day for each capture date. Or, choosing 
2021 October 03 simply creates one folder per 
date, as shown in the illustration at the right.

Think about which system of folder organization 
best suits your needs before you import photos from 
your camera, and then main tain that system for all 
your camera imports.

5  For the purposes of this exercise (and what  
I recommend to everyone as a default), choose 
Into One Folder from the Organize menu.

6  Select the Into Subfolder option at the top of 
the panel, type Lesson 2 Import in the adjacent 
text box as the new subfolder’s name, and press 
Return/Enter. The subfolder should then appear 
inside the folder you chose in the bottom section 
of the Destination panel.

P Note: If your 
memory card has been 
recognized as a remov-
able disk, you may also 
see the Organize option 
By Original Folders; this 
option will be discussed 
later in this lesson.
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Review Questions
1 Review uses Number List

About file formats
Camera raw formats Camera raw file formats contain unprocessed data from a digital camera’s 
sensor. Most camera manufacturers save image data in a proprietary camera format. Lightroom reads 
the data from most cameras and processes it into a full-color photo. You can use the controls in the 
Develop module to process and interpret the raw image data for your photo. For a list of supported 
cameras and camera raw formats, see https://helpx.adobe.com/photoshop/camera-raw.html.

Digital Negative format (DNG) The Digital Negative (DNG) file format is a publicly available archival 
format for raw files generated by digital cameras. DNG addresses the lack of an open standard for raw  
files created by individual camera models, ensuring that photographers will be able to access their files  
in the future. You can convert proprietary raw files to DNG in Lightroom. For more information about 
the Digital Negative (DNG) file format, visit https://helpx.adobe.com/photoshop/digital-negative.html.

TIFF format Tagged-Image File Format (TIFF, TIF) is used to exchange files between applications and 
computer platforms. TIFF is a flexible bitmap image format supported by virtually all paint, image-
editing, and page-layout applications. Also, virtually all desktop scanners can produce TIFF images. 
Lightroom supports large documents saved in TIFF format (up to 65,000 pixels per side). However, 
most other applications, including older versions of Photoshop (pre-Photoshop CS), do not support 
documents with file sizes greater than 2 GB. The TIFF format provides greater compression and indus-
try compatibility than Photoshop format (PSD) and is the recommended format for exchanging files 
between Lightroom and Photoshop. In Lightroom, you can export TIFF image files with a bit depth of 
8 bits or 16 bits per channel.

JPEG format Joint Photographic Experts Group (JPEG) format is commonly used to display photo-
graphs and other continuous-tone images in web photo galleries, slideshows, presentations, and 
other online services. JPEG retains all color information in an RGB image but compresses file size by 
selectively discarding data. A JPEG image is automatically decompressed when opened. In most cases, 
the Best Quality setting produces a result indistinguishable from the original.

Photoshop format (PSD) Photoshop format (PSD) is the standard Photoshop file format. To import 
and work with a multi-layered PSD file in Lightroom, the file must be saved in Photoshop with the  
Maximize PSD and PSB File Compatibility option activated. You’ll find this option in the Photoshop  
file handling preferences. Lightroom saves PSD files with a bit depth or 8 bits or 16 bits per channel.

PNG files Lightroom imports PNG files, but transparency is not supported; it will appear white.

CMYK files Lightroom imports CMYK files, but edits and output are performed in the RGB color space.

Video files Lightroom will import video files from most digital cameras. You can tag, rate, filter, and  
include video files in collections and slideshows. Video files can be trimmed, and also edited with most 
of the Quick Edit controls. Click the camera icon on the video file’s thumbnail to launch an external 
viewer such as QuickTime or Windows Media Player.

File format exceptions Lightroom does not support the following types of files: Adobe Illustrator® 
files, Nikon scanner NEF files, files with dimensions greater than 65,000 pixels per side or larger than 
512 megapixels.

Note: To import photos from a scanner, use your scanner’s software to scan to TIFF or DNG format.

https://helpx.adobe.com/photoshop/camera-raw.html
https://helpx.adobe.com/photoshop/digital-negative.html
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Review Questions
1 Review uses Number List

Creating import presets
When you import photos on a regular basis, you’ll probably find that you’re setting up the same 
configurations of options over and over. Lightroom Classic enables you to streamline your import 
workflow by saving your preferred settings as import presets. To create an import preset, set up your 
import in the expanded Import dialog box, and then choose Save Current Settings As New Preset 
from the Import Preset menu below the Preview pane.

Type a descriptive name for your new preset, and then 
click Create.

Your new preset will include all of your current set-
tings: the source, import type (Copy as DNG, Copy, 
Move, or Add), file handling and renaming options, develop and metadata presets, keywords, and 
destination. You might set up one preset to move photos from a memory card to your computer, and 
another preset to import from a memory card to a network-attached storage device. You could even 
create separate import presets tailored to the characteristics of different cameras, so you can quickly 
apply your favorite noise reduction, lens correction, and camera calibration settings during the import 
process, saving yourself time in the Develop module later.

Using the Import dialog box in compact mode

Once you’ve created the presets you need, you can speed up the process even more by using the 
Import dialog box in compact mode, where you can use your import preset as a starting point and 
then change the source, metadata, keywords, and destination settings, as required. 
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Backup strategies
Your next choice is whether to make backup copies of the images from your camera 
at the same time as Lightroom creates primary copies in the location you’ve just 
specified and adds them to the library catalog. For some, it’s a good idea to create 
backup copies on a separate hard disk or on external storage media so you don’t lose 
your images if your hard disk fails or you accidentally delete them.

1 In the right panel group of the Import dialog box, expand the File Handling 
panel and select the Make A Second Copy To option.

2  Click the small triangle 
to the right and select 
Choose Folder to specify a 
destination for your backup 
copies.

3  In the Browse For Folder/ 
Choose Folder dialog box, navigate to the folder in which you wish to store the 
backup copies of your images, and then click Choose/Select Folder.

Keep in mind that the purpose of this backup is mainly as a precaution against loss 
of data due to disk failure or human error during the import process; it’s not meant 
to replace the standard backup procedure you have in place—or should have in 
place—for the files on your hard disk.

For the most part, I don’t use this backup option, but rely instead on a combina-
tion of my computer’s backup system (Time Machine) and the use of my network-
attached storage device. This is part of my personal workflow strategy, which I’ll 
share with you and explain later on in the book.

Renaming files as they are imported
The cryptic filenames created by digital cameras are not particularly helpful  
when it comes to sorting and searching your photo library. Lightroom can help by 
renaming your images for you as they are imported. You can choose from a list of 
predefined naming options or create your own customized naming templates.

1 In the right panel group of the 
Import dialog box, expand the  
File Renaming panel and select 
Rename Files. Choose Custom 
Name - Sequence from the 
Template menu, type a descriptive 
name in the Custom Text box,  
and then press the Tab key on  
your keyboard. A sample name at the bottom of the File Renaming panel shows 
how your settings will be applied for the first image imported. You can enter 

E Tip: An option you 
should consider, if it’s 
supported by your cam-
era, is to set the camera 
to generate filenames 
with unique sequence 
numbers. When you 
clear your memory card, 
or change memory 
cards, your camera will 
continue to  generate 
unique sequence 
numbers rather than 
starting the count from 
one again. This way, the 
images you import into 
your library will always 
have unique filenames.
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a number other than 1 in the Start Number text box; this is useful if you’re 
importing more than one batch of images from the same shoot or series (often 
from multiple memory cards).

2  Click the small triangle to the right of the Custom Text box; your new text has 
been added to a list of recently entered names. You can choose from this list if 
you import another batch of files that belong in the same series. This not only 
saves time and effort, but helps you ensure that subsequent batches are named 
identically. To clear the list, choose Clear List from the menu.

3  Choose Custom Name (x of y) from the Template menu. Note that the sample 
name at the bottom of the File Renaming panel is updated to reflect the change.

4  Choose Edit from the Template menu to open the Filename Template Editor. 
Choose Custom Name - Sequence from the Preset menu.

In the Filename Template Editor dialog box, you can set up a filename template that 
makes use of metadata information stored in your image files—such as filenames, 
capture dates, or ISO settings—adding automatically generated sequence numbers 
and any custom text you specify. A filename template includes placeholders—or 
tok e n s—that will be replaced by actual values during the renaming process. A token 
is highlighted in blue on macOS and framed by curly brackets on Windows.

You could rename your photos  
vacation_images-20211004-0001, and 
so on, by setting up a filename template 
with a custom text token, a date token, 
and a four-digit sequence number token, 
separated by typed hyphens, as shown at 
the right. Let's remove the Custom Text 
token by selecting and deleting it. 

5  Choose Save Current Settings As  
New Preset from the Preset menu  
at the top.

6  Type Date and 4 Digit Sequence for 
your preset name, click Create, and 
then click Done.

Despite all of the options available for 
renaming your images during the import process, there’s only so much information 
you can squeeze into a single filename. While you may be tempted to be descriptive 
in your filenames, consistency is key for your archive, and the more streamlined you 
keep it, the better. This simple organization of dates and sequences in the actual files 
will pay off in speed and efficiency. Lightroom’s strength is in its ability to find your 
images through the use of things like metadata, keywords, and collections. In these 
areas, you can be a lot more descriptive than the limited confines of the filename. 

E Tip: For more 
information on using 
the Filename Template 
Editor, please refer to 
Lightroom Help.
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Review Questions
1 Review uses Number List

Tips for naming your files and folders
We’ve talked about the importance of naming your files and folders to better organize your photos, 
and I gave you an example of how to name them. Here are some tips and suggestions for renaming:

• Name your files and folders similarly to make it easier to find the photos you want later.

• Start the name of every file with the year, then add a month and day.

• Use lowercase when naming your files and folders. 

• If you believe it is necessary, add a descriptive word about the shoot after the date, and keep it as 
short as possible.

• If you need to add a space in your name, use 
an underscore (_) instead of a space.

• At the end of the filename, add C1, C2, C3, 
and so on, for card 1, card 2, card 3. This helps 
when you have a shoot that spans multiple 
memory cards.

For example, if I want to import images that I took 
of my family on October 4, 2021, my folder would 
be named 20211004_family. If I only shot one card 
during that shoot, the filename would be 20211004_family_c1_sequential file number. Is the filename 
long? Yes. Does it give you all of the information about the shoot? Absolutely.

Here’s the practical reason for adding the C1 to 
your filenames: Every now and then, during a 
Lightroom import, you will run into a file that 
looks like the one here. While it may make for an 
interesting art project, it’s actually something a lot 
more sinister. It is a corrupt picture, a quick sign 
that the card you used may not be as reliable as 
you thought. Memory cards, like everything else, 
can fail over time, and you cannot afford to lose an 
important shoot because of it. If you are importing 
from multiple cards, how do you tell which one is 
the bad one?

As soon as I purchase a memory card, I make it a point to label it using those C numbers. Then, I add 
that C number to the filename. The moment I see a potential problem with an image, I can look at  
the name and know exactly which card failed, so I can take that card out of rotation…and give it to  
a friend. Kidding! Simply labeling your memory cards and adding that C1 or C2 to your filenames can 
go a long way to helping you troubleshoot. Anal? Yes. Vital? Absolutely.
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You’ll learn about working with metadata, keywords, and collections in the follow-
ing exercises and in Lesson 4, “Managing Your Photo Library.”

6  For now, click Import if you wish to bring your photos into the LRC2022CIB 
catalog or Cancel to close the Import dialog box without importing any images.

You have now completed this exercise on importing photos from a digital camera or 
a memory card. You’ll learn about the other options that are available in the Import 
dialog box in the exercises to follow.

Importing images from a hard disk
When you import photos from your hard disk or from external drives, Lightroom 
Classic offers you more options for organizing your image files than are available 
when importing from a camera.

You can still choose to copy your images to a new location during the import pro-
cess, as you did in the previous exercise, but you also have the option to add them 
to your catalog without moving them from their current location. You might choose 
to do this if the images you wish to import are already well organized in a folder 
structure on your drive.

For images that are already located on your hard disk, you have an extra option: to 
move them to a new location and remove them from their original location at the 
same time as they are added to your catalog. This option might appeal if the images 
on your hard disk are not already well organized.

1 To import the images for this exercise from your 
computer hard disk, either choose File > Import 
Photos And Video, press Shift+Command+I/
Shift+Ctrl+I, click the Import button below the 
left panel group in the Library module, or drag 
the folder onto Lightroom’s Library module.

2  In the Source panel at the left of the Import 
dialog box, navigate to the Lessons folder inside 
the LRC2022CIB folder on your hard disk. 
Click the lesson02 folder and select Include 
Subfolders at the upper right of the panel (it’s 
best to leave this on unless you have some 
images you don’t want to import).

An image count in the lower-left corner of the 
Import dialog box shows that the lesson02 folder 
contains a total of 13 photos with a combined file 
size of 71 MB.

E Tip: The same 
commands apply for 
importing images from 
a CD, DVD, or other 
external storage media.
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3  From the import type options in the center of the top panel, click Add so that 
your photos will be added to your catalog without being moved—an option that 
is not available when importing images from a camera. Do not click Import yet!

4  Use the scrollbar at the right of the Preview pane to view all of the images in the 
lesson02 folder. Drag the Thumbnail slider below the Preview pane to the left to 
reduce the size of the thumbnails so that you can see as many of the images as 
possible in the Preview area.

5   In the Source panel, notice the Include Subfolders option. This checkbox allows 
you to add images from within subfolders, which is handy to have with larger 
image collections you may be importing.

Before we go any further, let’s review each of the import type options above the 
Preview area.

6  Click each of the import type options in turn, from left to right:

•  Copy As DNG will have Lightroom make copies of your images in DNG 
(digital negative) file format, which will be stored in a new location and then 
added to your catalog. You’ll notice that for the Copy As DNG, Copy, and 
Move options, the right panel group offers the same suite of panels—File 
Handling, File Renaming, Apply During Import, and Destination.
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•  Click Copy to have Lightroom create copies of your images in a new location, 
and then add them to your catalog, leaving the originals in their current 
locations. You can set a destination for your copies in the Destination panel, 
as you did in the previous exercise. Expand the Destination panel and click 
the Organize menu. When you use either the Copy As DNG, Copy, or Move 
option to import images from your hard disk or from external storage media, 
the Organize menu offers you the option to copy your photos into a single 
folder, into subfolders based on the capture dates, or into a folder structure 
that replicates the original arrangement.

•  Click Move to have the images moved to a new location on your hard disk, 
arranged in whatever folder structure you choose from the Organize menu, 
and then deleted from their original locations.

•  Click Add to add the images 
to your cat alog without mov-
ing or copying them from 
their current locations or 
altering the folder structure 
in which they are stored. For 
the Add option, the right 
panel group offers only the 
File Handling and Apply 
During Import panels; you 
cannot rename the original 
source images during import, 
and there’s no need to specify 
a destination because the 
files remain where they are.

P Note: Expand the 
File Handling and Apply 
During Import panels 
to see the options 
available.
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Applying metadata
Lightroom uses information attached to files to enable you to quickly find and orga-
nize your photos. This information is known as metadata. Some of this metadata is 
automatically added to the file at the point of creation (shutter speed, ISO, camera 
type, and so on), and some of it can be added after the fact (keywords, your name, 
and so on).

You can search your image library and filter the results by all of this metadata, as 
well as things like flag status, color label, shooting settings, or any combination of  
a wide range of other criteria.

You can also choose specific information about your images from this metadata and 
have Lightroom display it as a text overlay applied to each image in a slideshow, web 
gallery, or print layout.

Let’s add some important information into our files quickly, and make sure we don’t 
have to reinvent the wheel every time. For this, we’ll use metadata presets.

1 In the Apply During Import panel, choose New from the Metadata menu.

2  Let’s create a metadata preset that includes your copyright information in each 
file. In the New Metadata Preset dialog box, for Preset Name, type Copyright 
Info [year]. Then, enter your copyright information into the IPTC Copyright 
fields and contact information into the IPTC Creator fields. This should give 
anyone online enough information to get a hold of you should someone find 
your image interesting and want to use it. It does happen at times.

P Note: Remember 
that any image that is 
shared with metadata 
online can be read by 
anyone online. While 
adding your email 
address and website are 
totally fine, do not put 
in any more personal 
information, such as 
your home address or 
phone number. That 
information in the 
wrong hands could be 
bad, so leave it out! 
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3  Click Create to close the New Metadata Preset dialog box, and then confirm that 
your new metadata preset is selected in the Metadata menu.

4  Also in the Apply During Import panel, choose None from the Develop Settings 
menu and type Lesson 02, Nostalgia in the Keywords text box.

5  In the File Handling panel, choose Minimal from the Build Previews menu. 
Check that your settings are the same as those shown in the illustration here, 
and then click Import.

The images from the lesson02 folder are imported into your library catalog, and 
thumbnails of the images appear in both the Grid view and the Filmstrip in the 
Library module.

6  Right-click the lesson02-0012 image in the Grid view and choose Go To Folder 
In Library from the menu.

In the Folders panel in the left panel group, the 
lesson02 folder is highlighted, and the image 
count indicates that it contains 13 photos.

Right-clicking the folder at this point gives you options to update folder locations, 
or even find the folder of images inside of Finder (on macOS) or Explorer (on 
Windows). This comes in handy when you are missing folders, but we’ll talk more 
about that later in the book. For now, choose Show In Finder/Show In Explorer to 
see the folder.
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Importing via drag and drop
Perhaps the easiest way to add photos to your image library is to simply drag  
a selection of files—or even an entire folder—directly into Lightroom Classic.

1 The Finder/Explorer window, where you can see the lesson02A folder, should 
still be open from the previous exercise. Position the window so that you can see 
the Grid view in the Lightroom Classic workspace behind it.

2  Drag the lesson02A folder from the Finder/Explorer window onto the Grid view.

In the Import dialog box, the lesson02A folder is now selected in the Source panel, 
and the photos it contains are displayed in the Preview area.

3  In the Apply During Import panel, choose your new Metadata preset and type 
Lesson 02, Hepburn in the Keywords box. Don’t click Import just yet.



ADOBE PHOTOSHOP LIGHTROOM CLASSIC CLASSROOM IN A BOOK (2022 RELEASE) 71

Evaluating photos before importing
Lightroom Classic makes it easy to decide which of your photos you wish to import 
by providing an enlarged Loupe view in the Import dialog box; you can examine 
each image in detail so that you can choose between similar images or exclude a 
photo that is out of focus.

1 Double-click any of the thumbnails to see the photo in Loupe view, or select 
the thumbnail and click the Loupe view button at the left of the Toolbar below 
the preview pane; the image is enlarged to fit the preview area, and the pointer 
becomes a magnifying glass cursor. Depending on the size of your display and/or 
the application window, you may first see a Zoom Out cursor.

2  If necessary, click the image again to further magnify the image to a zoom ratio 
of 1:1. Use the Zoom slider below the preview pane to see even more detail. Drag 
the enlarged image in the preview pane to pan the view so that you can inspect 
portions of the photo that are not currently visible.

While you’re examining the photo in Loupe view, you can select or deselect the 
Include In Import option in the Toolbar below the image preview. 

3  Click the enlarged preview to return to the Fit view, where the entire image  
is visible. Double-click the image, or click either the Loupe view button or the 
Grid view button beside it, to return to the thumbnail display.

4  Let's go ahead and keep all of the images selected in this folder.
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Images that are already imported
Lightroom does a great job at trying to keep your collection organized and free from 
duplicates. During the import process, you’ll notice that there is an option in the 
File Handling panel on the right side that prevents you from importing images that 
have already been added to your Lightroom catalog. When you are just starting out 
with Lightroom, it’s a great idea to keep this selected.

When you try to import from a memory card or folder that you have already 
imported from, any of the images that are duplicates (that are already in your 
Lightroom catalog) appear in gray and will not be selected for import. If the card  
or folder has new images, those images will be visible and will already be selected, 
letting you specify where you would like them imported.

As a general rule, I advise photographers never to format their memory cards until 
after they have used up all of the cards they own. For example, if I have four memory 
cards (A, B, C, and D) and I make images on card A, I will import that card into 
Lightroom but will not format it. At the next shoot, I use card B and repeat the pro-
cess. The following shoot? Card C.

Should something go wrong on my computer, I have a much better chance of recov-
ering the images from the memory cards if I stagger the formatting in this manner. 
Working this way, you may forget to format a card and shoot with one that you’ve 
already imported. Thankfully, Lightroom is there to catch these kinds of things. Go 
ahead and import the images from the lesson02A folder that aren't duplicates.

E Tip: While I suggest 
you stagger your shoots 
across multiple memory 
cards, you don’t need to 
buy four memory cards. 
You can stagger shoots 
across as many cards 
as you own. Think of 
this as a workflow sug-
gestion, but I can’t tell 
you how many times 
this has saved me from 
losing images.
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Importing to a specific folder
From within the Library module, you can 
import photos directly to a folder in the 
Folders panel without needing to specify  
a destination in the Import dialog box.

1 In the Folders panel, right-click the 
lesson02A folder and choose Import To 
This Folder from the menu.

Importing and viewing video
Lightroom Classic will import many common digital video files from digital  
still cameras, including AVI, MOV, MP4, AVCHD, and HEVC. Choose File > 
Import Photos And Video or click the Import button in the Library module, 
then set up your import in the Import dialog box, just as you would for photos.

In the Library module Grid view, you can scrub backward and forward in your 
video clips by simply moving the mouse over the thumbnails, making it easy 
to select the clip you want. Double-click a thumbnail to preview the video in 
Loupe view; drag the circular current time indicator in the playback control bar 
to scrub through the video manually.

Setting distinctive thumbnail images (poster frames) for your videos can make 
it easier to find the clip you want in the Grid view. Move the current time 
indicator to the frame you want; then, click the Frame button in the control bar 
and choose Set Poster Frame. Choose Capture Frame from the same menu to 
convert the current frame to a JPEG image that will be stacked with the clip. 
To shorten a video clip, click the Trim Video button. The playback control bar 
expands to display a timeline view of the clip where you can drag the start and 
end markers to trim the clip as desired.

P Note: HEVC 
(MOV) video files are 
support ed for import 
and playback on  
macOS High Sierra 
(10.13) or later and 
Windows 10 only.
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2  This will automatically bring up the Import dialog box. Notice that the 
Destination is already selected for you.

3  In the Source panel, you’ll notice that you have your hard drive, any connected 
memory cards, and any network drives available to you for import.

4  All of the other panels are available for you to use. From here, you can still apply 
metadata templates, change the filename, add keywords, and so forth. Click 
Cancel when done.

This feature is useful when you are working with multiple memory cards and want 
to have all of them available to import to a shoot. That said, Lightroom does a great 
job of remembering the last location you saved to, so you may find that you rely on 
this a lot less than you’d think.

Importing from a watched folder
Designating a folder on your hard disk as a wa tc he d  f ol d e r  can be a very  convenient 
way to automate the import process. Once you’ve designated a folder that is to be 
watched, Lightroom will detect any photos that are placed or saved into it, and then 
automatically move them to a specified location and add them to the catalog. You 
can even have Lightroom rename the files and add metadata in the process.

1 Choose File > Auto Import > Auto Import Settings. In the Auto Import Settings 
dialog box, click the first Choose button to designate a watched folder. Navigate 
to your desktop, create a new folder, name it Watch This, then click Choose/
Select Folder.
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Importing a Photoshop Elements catalog
Lightroom Classic makes it easy to import photographs and videos from Photoshop Elements 6 and 
later on Windows, and from Photoshop Elements 9 and later on macOS.

The media files from your Photoshop Elements catalog are imported complete with keywords, ratings, 
and labels—even your stacks are preserved. Version sets from Photoshop Elements are converted to 
stacks in Lightroom Classic, and your albums become collections.

1 In the Lightroom Classic Library module, choose File > Import A Photoshop Elements Catalog.

Lightroom searches your computer for Photoshop Elements catalogs and displays the most 
recently opened catalog in the Import Photos From Photoshop Elements dialog box.

2  If you wish to import a Photoshop Elements catalog other than that selected by default, choose it 
from the menu.

3  Click Import to merge the photo library and all catalog information from your Photoshop 
Elements catalog to your Lightroom Classic catalog. 

If you’re migrating from Photoshop Elements to Lightroom Classic, or intend to use the two applica-
tions together, refer to the Adobe tutorial “Step up from Photoshop Elements to Adobe Lightroom 
Classic” for useful tips and info:  
helpx.adobe.com/lightroom-classic/how-to/elements-upgrade-creative-cloud-photography.html.

http://helpx.adobe.com/lightroom-classic/how-to/elements-upgrade-creative-cloud-photography.html
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2  Now that you have designated a watched folder, you can click the checkbox at 
the top of the Auto Import Settings dialog box to Enable Auto Import.

3  Under Destination, click the Choose button to specify a folder to which 
Lightroom will move your photos when adding them to the library catalog. 
Navigate to and select the lesson02A folder, and then click Choose/Select  
Folder. Type Auto Imported in the Subfolder Name text box.

4  Under Information, select the metadata preset that we made in the previous 
exercise, choose None from the Develop Settings menu, and choose Minimal 
from the Initial Previews menu. Click OK to close the Auto Import Settings 
dialog box.

5  Switch to Finder/Windows Explorer and navigate to the lesson02B folder. Open 
the Watch This folder and drag the image files inside this watched folder.
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When Lightroom has finished importing, you’ll notice that the images are automati-
cally placed into the Auto Imported folder we specified during the watched folder 
creation. Looking at the Watch This folder, you’ll see that it is now empty.

In Lightroom, if you navigate to the lesson02A folder, you’ll notice that there are 
several more pictures that have been added to that folder.

You’ll find that this watched folder feature is very commonly used by photogra-
phers who are performing tethered shooting using the manufacturer’s software to 
control the camera. Dedicated to supporting photographers every step of the way, 
Lightroom also handles this type of shooting quite well. Want to learn more about 
tethered shooting? We’ll cover that in the next section.

E Tip: Once you’ve set 
a watched folder, you 
can activate or disable 
Auto Import at any time, 
without opening the 
Auto Import Settings 
dialog box, by choosing 
File > Auto Import >  
Enable Auto Import. 
A checkmark beside 
this menu command 
indicates that the 
Auto Import feature is 
currently enabled.
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Specifying initial previews  
when importing
As photos are imported, Lightroom can immediately display a photo’s embedded 
preview or display higher-quality previews as the program renders them. You can 
choose the rendered size and quality for previews using the Standard Preview Size 
and Preview Quality menus on the File Handling tab of the Catalog Settings dialog 
box (choose Lightroom Classic > Catalog Settings/Edit > Catalog Settings). Please 
keep in mind that embedded previews are created on the fly by cameras and are 
not color managed, therefore they don’t match the interpretation of the camera’s 
raw files made by Lightroom. Previews rendered by Lightroom are color managed.

In the Import Photos dialog box, choose one of the four Build Previews options:

• Minimal displays images using the smallest previews embedded in the photos; 
Lightroom renders standard-size previews as needed.

• Embedded & Sidecar displays the largest possible preview available from the 
camera; it's slower than a Minimal preview but faster than a Standard preview.

• Standard displays previews as Lightroom renders them. Standard-size previews 
use the ProPhoto RGB color space.

• 1:1 displays a one-to-one view of the actual pixels.

You can also choose to build Smart Previews during the import process. Smart 
Previews are compressed, high-resolution previews that allow you to work on your 
photos even when the originals are offline. They support editing at high magnifi-
cation, though they are a fraction of the size of the source files. Generating Smart 
Previews for a large import takes time, but adds a lot of flexibility to your workflow.

Tethered shooting
Many modern digital cameras support tethered shooting, a process where you con-
nect—or tether—your digital camera to your computer and save images to the com-
puter’s hard disk rather than to the camera’s memory card. With tethered shooting, 
you can view a photo on your computer screen immediately after you shoot it—a 
vastly different experience from seeing it on your camera’s LCD screen.

For a range of DSLR cameras, including many models from Canon and Nikon, you 
can capture photographs directly into Lightroom Classic without the need for any 
third-party software. If your camera allows tethered shooting but is not on the list 
of models supported by Lightroom Classic, you can still capture images into your 
Lightroom Classic library using either the image capture software associated with 
the camera or any of a number of third-party software solutions.

You can have Lightroom name the photos, add metadata, apply developing settings, 
and organize them in your library then and there. If necessary, you can adjust your 

E Tip: Please refer to  
Lightroom Classic Help 
to see a list of cameras 
currently supported 
for integrated tethered 
shooting.
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camera settings (white balance, exposure, focus, depth of field, and others), or even 
change cameras, before taking the next shot. The better the quality of the captured 
image, the less time you’ll need to spend adjusting it later.

Tethered shooting with a supported camera
1 Connect your camera to the computer.

2  In the Library module, choose File > Tethered Capture > Start Tethered Capture.

3  In the Tethered Capture Settings dialog box, type a name for your shooting 
session. Lightroom will create a folder with this name inside the destination 
folder of your choice; this session folder will appear in the Folders panel.

4  Choose a naming scheme for your shots, select a destination folder, and specify 
any metadata or keywords that you want Lightroom to apply as the newly 
captured images are imported.

5  Click OK to close the Tethered Capture Settings dialog box. The tethered 
capture control bar appears.

The control bar displays the model name of the connected camera, the name you 
entered for the shooting session, and the current camera settings, all of which you 
can change. You can choose from a wide range of Develop presets in the Develop 
Settings menu at the right. You can trigger the shot with your camera’s shutter button 
by clicking the large circular button at the right of the control bar or by pressing F12 
on your keyboard.

P Note: Depending on 
your camera model and 
the operating system 
your computer uses, 
you may also need to 
install the necessary 
drivers for your camera.

E Tip: To collapse the 
control bar to just the 
shutter button, hold 
down the Option/Alt 
key and click the Close 
button at the upper 
right. Repeat to expand 
the control bar again.



80 LESSON 2 Bringing Photos into Lightroom Classic

As you shoot, the images captured will appear in both the Grid view and the 
Filmstrip. To see each captured photo as large as possible, switch to the Loupe  
view and hide unwanted panels or choose Window > Screen Mode > Full Screen 
And Hide Panels.

Viewing imported photos in the work area
In the Library module, the main display area—the work area—in the center of the 
application window is where you select, sort, search, review, and compare images. 
The Library module work area offers a choice of view modes to suit a range of tasks, 
from organizing your photos to choosing between similar shots.

1 If you’re not already in the Library module, switch to it now. Select All 
Photographs in the Catalog panel to see all of the images you have imported.

Depending on your workspace setup in the Library module, you may see the 
Filter bar across the top of the work area. You can use filters to limit the images 
that are displayed in the Grid view and the Filmstrip so that you’ll see only those 
photos with a specified rating or flag status, or with particular  metadata content.

The Toolbar, located at the bottom of the work area, is common to all of the 
workspace modules, but contains different tools and controls for each.

2  If the Filter bar is not already visible, show it by pressing the backslash key (\)  
on your keyboard or by choosing View > Show Filter Bar. Press the backslash  
key again or choose View > Hide Filter Bar to hide it.

P Note: You’ll learn 
more about using the 
Filter bar controls in 
Lesson 4.
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3  If the Toolbar is not already visible, press T to show it. Press T again to hide it. 
Switch to the Develop module. If the Toolbar is not already visible, press T to 
show it. Switch back to the Library module. In the Library module, the Toolbar 
is still hidden; Lightroom remembers your Toolbar setting for each module 
independently. Press T to show the Toolbar in the Library module.

4  Double-click an image in Grid view to switch to Loupe view. The Loupe view is 
available in both the Library and Develop modules, but the controls available in 
the Loupe view Toolbar differ for each of these modules.

5  To hide or show individual tools, click the white arrow at the right end of the 
Toolbar and choose their names from the menu. Tools that are currently visible 
in the Toolbar have a checkmark in front of their names.

Setting Grid and Loupe view options
You can choose from many options in the Library View Options dialog box to cus-
tomize the information Lightroom Classic displays for each image in the Grid and 
Loupe views. For the Loupe view overlay and thumbnail tool tips, you can activate 
two sets of options, and then use a keyboard shortcut to switch between them.

1 Press G to switch to Grid view in the Library module. Press Shift+Tab to hide all 
of the panels and focus on your grid of images.

2  Choose View > View Options. The Library View Options dialog box appears with 
the Grid View tab already selected. Position the Library View Options dialog box 
so you can see some of the images in the Grid view.

E Tip:  If you activate 
more tools than can be 
displayed in the width 
of the Toolbar, you can 
increase the Toolbar’s 
width by hiding the 
side panel groups or 
disabling tools that 
you don’t need at the 
moment.
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3  At the top of the Grid View tab, deselect Show Grid Extras. This disables most of 
the other options.

4  The only options still available are Tint Grid Cells With Label Colors and  
Show Image Info Tooltips. If they’re not already activated, select both of 
these options. As this lesson’s images have not yet been assigned color labels, 
activating the first option has no visible effect in the Grid view. Right-click any 
image—you can do this while the Library View Options dialog box is open—and 
choose a color from the Set Color Label menu.

In the Grid view and the Filmstrip, a color-labeled image that is currently 
selected will show a thin colored frame around the thumbnail; a color-labeled 
image that is not selected has a tinted cell background.
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5  Position the pointer over a thumbnail in the Grid view or the Filmstrip; a tool 
tip appears. In macOS you’ll need to click anywhere in the Lightroom Classic 
workspace window to bring it to the front before you can see the tool tips.

By default, the tool tip will display the filename, the capture date and time, and the 
cropped dimensions. You can specify the information to be displayed in the tool tip 
by choosing from the Loupe View options.

6  On macOS, if the Library View Options dialog box is now hidden behind the 
main application window, press Command+J to bring it back to the front.

7  On the Grid View tab, select the Show Grid Extras option and choose Compact 
Cells from the menu beside it. Experiment with each setting to see its effect in 
the Grid view display. Select and deselect the settings for Options, Cell Icons, 
and Compact Cell Extras. Position the pointer over the various icons in the 
image cells to see tool tips with additional information.

8  Under Compact Cell Extras, click the Top Label menu to see the long list of 
choices available. For some choices, such as Title or Caption, nothing will be 
displayed until you add the relevant information to the image’s metadata.

9  Now choose Expanded Cells from the Show Grid Extras menu. Experiment  
with the Expanded Cell Extras options to see the effects in the Grid view.  
Click any of the Show Header With Labels menus to see the many choices 
available to customize the information that is displayed in the cell headers.
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10  Click the Loupe View tab. The work area switches to Loupe view so you can 
preview the changes you’ll make in the Library View Options dialog box.

For the Loupe view, you can select the Show Info Overlay option to display image 
information in the upper-left corner of the view. Choose items from the menus in 
Loupe Info 1 and Loupe Info 2 to create two different sets of information, and then 
choose either set from the Show Info Overlay menu.

You can reset either group to its default state by clicking its Use Defaults button. 
Select Show Briefly When Photo Changes instead of Show Info Overlay to show  
the info overlay for only a few seconds when a new image is displayed in the Loupe 
view. Select the Show Message When Loading Or Rendering Photos option to dis-
play a notification in the lower part of the view while the image preview is updated.

11 Click the Close button to close the Library View Options dialog box.

12  You can choose which of the two information sets will be displayed by choosing 
an option from the View > Loupe Info menu, or by pressing the I key to cycle 
the info overlay through Loupe Info 1, Loupe Info 2, and its disabled state.

13  Switch to the Grid view. From the View > Grid View Style menu, you can choose 
whether to display additional information using either the Compact Cells layout 
or the Expanded Cells layout. Press the J key to cycle through the cell layouts.

P Note: When you 
choose an information  
item such as Capture 
Date And Time, those 
details are drawn from 
the image metadata.  
If the image’s metadata 
does not contain the 
specified information,  
nothing will be dis-
played for that item. 
For both the Grid and 
Loupe view options you 
can choose the informa-
tion item Common 
Attributes, which will 
display the flag status, 
star rating, and color 
label for each image.



ADOBE PHOTOSHOP LIGHTROOM CLASSIC CLASSROOM IN A BOOK (2022 RELEASE) 85

Review questions
1 When would you choose to copy imported images to a new location on your hard disk, 

and when would you want to add them to your library catalog without moving them?

2  What is DNG?

3  When would you use the Import dialog box in compact mode?

4  Why would you use tethered shooting in Lightroom Classic?

5  How can you specify the information displayed for images in the Grid and Loupe views?

Review answers
1 When importing photos from a camera or memory card, the images need to be copied 

to a more permanent location, as memory cards are expected to be erased and reused. 
Copying or moving images also might be useful when you want Lightroom to organize 
the files into a more ordered folder hierarchy during the import process. Images that 
are already arranged in a useful way on the hard disk or removable media can be added 
to the library catalog in their current locations.

2  The Digital Negative (DNG) file format is a publicly available archival format intended 
to address the lack of an open standard for raw files generated by cameras. Converting 
raw files to DNG in Lightroom will help ensure that you’ll be able to access your raw 
files in the future even if the original proprietary format is no longer supported.

3  Once you’ve created import presets to suit your workflow, you can speed up the import 
process by using the Import dialog box in compact mode. Use your import preset as a 
starting point, and then modify the settings as required.

4  When shooting tethered into Lightroom, you can see the images much larger on your 
computer screen than on the LCD on your camera, allowing you to adjust your camera 
settings as you shoot to reduce the amount of postproduction work needed.

5  You can choose from the many options in the Library View Options dialog box  
(View > View Options) to customize the information Lightroom Classic displays for 
each image in the Grid and Loupe views. For the Loupe view and thumbnail tool tips, 
you can define two sets of options and then press the I key to switch between them. 
From the View > Grid View Style menu you can switch between Compact or Expanded 
Cells and activate or disable the display of information for either style.
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NUMBERS
16-bit printers, 354

A
access hierarchy, 401
active image, 108
Add New Mask tool, 224
adding photos, 50–85
Adjustment brushes, 201
Adobe Creative Cloud, 6
advanced editing. See also editing

AI-based tools, 224–236
black-and-white images, 

252–256
creative color tools, 252–256
digital tablet for, 244
HDR images, 259–262
HSL adjustments, 250–252
lesson on, 218, 220–223
Linear Gradient, 236–239
Masking Brush, 242–244
panoramas, 256–259, 262–264
Radial Gradient, 240–242
review questions on, 270–271
Spot Removal tool, 245–250
time-saving tips, 264–269
tone curve changes, 250–252

Amount slider, 205
artificial intelligence tools

adding/subtracting selections, 
227–229

color/luminance range, 
229–233

efficiency of, 225
Enhance Details, 209
for Lightroom mobile, 236
mask combinations, 233–235
new features, 224–225
Select Sky/Select Subject, 

225–227
aspect ratio, 186–187
Attributes filter

in Filmstrip header, 171
finding photos via, 168, 169
use of tool, 154

Auto Import, 77

B
Back Up Catalog, 370–371
backgrounds

for photo books, 287–288
printable page, 350–351

backups
catalog files, 370–373
data loss prevention, 370
exports and, 376–385
file variety for, 369
hard drive, 407
hot status projects, 399–400
lesson on, 366, 368–369
library, 374–375
review questions on, 386–387
tips for, 62

badges, thumbnail, 133, 148, 285

INDEX
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Barker, Erika, 362–365
Baseline control, 291
Basic panel, 183
Before/After tool, 33, 182
BenQ Monitors, 355
black-and-white images, 252–256
blackbody radiation theory, 193
blacks, adjusting, 197–200
blemish removal, 203
blocked (dark) areas, 195
blown out (light) areas, 195
Blurb.com, 281, 282, 295
Book module, 18, 280–288
borders, 342
brightness

and exposure/contrast, 194
Luminance Range tool, 232
of luminance values, 198
tone mapping for, 259–260
white/black adjustments and, 200

Brush tool
AI-based functionality, 224, 225
for exposure adjustments, 235
for Linear Gradient, 238, 239
Masking Brush, 242–244
settings, 243

C
calibration, 355, 359
Calibrite, 355
Camera Matching profiles, 188, 189
cameras

black-and-white images on, 252
dynamic range of, 259
film, 86
imports from, 53–54, 55–59
metadata added by, 158
mirrorless, 369
profiles, 187–190
tethered shooting with, 78–79

understanding of light by, 298
candidate image, 107, 122
captions, 292–293, 346
catalog files

backing up, 370–373
deleting images from, 111
as digital notebook, 12, 52–53
exporting, 374–375
for lesson files, 4–6
managing photos in, 12–13
organization via, 12, 20–21
syncing from, 143

Catalog panel, 133
cells
cell padding, 286
cell spacing, 340

creating a custom layout with, 
348–350

photo, 286–287, 338, 339
Cells panel, 341
chromatic aberrations, 207
cinematic color grading, 188
clarity, 201–204
Classroom in a Book series, 1
clean computers, 394
clipping

histograms and, 199
light adjustments and, 195, 197

Clone option, 39, 245
CMYK files, 60
cold status, 395
collaborations, 151
collapsing panels, 98–100
collection sets

for hot status projects, 397–399
how to use, 137–141
in workflow hierarchy, 133

collections
color-coded, 147, 157
creating new, 134–135, 136–137

http://Blurb.com
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folders as source for, 136
GPS metadata for, 165
hot, medium, and cold, 395
hot status, 397–399
how to use, 24–26
Lightroom options for, 133
naming tips, 137
organization via, 133–142
photo books as, 294
previous imports in, 184
Print module, 334
print output settings, 358–359
publishing, 133
Quick Collection, 112–114
slideshow, 316
sort order for, 117
sub-categories in, 94
syncing, 143–146
using smart, 410–411
vs. folders, 132

color adjusting, 197–200
black-and-white images, 252–256
cast, 197
Color Range tool, 229–233
creative color tools, 252–256
grading, 253–254
HSL/Color adjustments, 250–251
identity plate, 343, 345
labels, 23, 147, 157
Lightroom previews of, 78
lookup tables (LUTs), 188
managing print, 354–357
profiles, 352, 356
raw image, 209
shifts and importing, 188
tone curve changes, 251–252
white balance, 191–193

color Range, 229–233
color space, 352–353
Compare mode, 27, 107–108

comparisons, 27–29
compressed files, 371
computers. See hardware; operating 

systems
contact sheet layouts

layout controls, 340
modifying, 340–341
options for, 336–337
presets, 335

context menu, 284
contrast, setting, 194–195, 206
Conzo, Joe, 86–89
cool color, 193
copies, virtual, 210–211, 212
copying images

collection copies, 26
organization of, 58–59
photo book copies, 295
vs. Add, 58

corrections, syncing, 266
corruption of files, 370, 373
Creative Cloud, 6
Creative Console, 172
Creative profiles, 188
Crop Overlay tool, 184, 186

cropping images
Crop Overlay tool, 34–35
Fujifilm camera crops, 245
how to, 184–187
culling images, 22–23, 172, 

396–397
customization
custom print layouts, 348–351
Develop module, 17, 183
metadata, 158
print template, 338–346
slideshow template, 309–313, 

318–320
Toolbar, 15
vignette, 37
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workspace, 17, 90, 91, 95–100
cylindrical panoramas, 257

D
data loss, 370
decompressing files, 371
deghosting, 261
deletions

accidental, 370, 371
collection, 25
image, 110–111
slideshow, 316
template, 320

demosaicing, 188, 209
detail, adding

how to, 205–207
via Enhance Details, 209
via Texture slider, 202–203

Detail slider, 206
Develop module

customizing, 17, 183
editing in, 29, 32–33, 178
HSL/Color adjustments, 250
impromptu slideshows, 322
overview of, 18, 182–183
presets, 267–268
resizing panels, 95
Scrubby Zoom, 104
soft proofing in, 352
workspace layout, 16

developing tools. See also editing
adding detail, 205–207
black/white adjustments, 197–200
camera profiles, 187–190
clarity, saturation, vibrance, 

201–204
collections from imports, 184
contrast and exposure, 194–195
cropping/rotating images, 

184–187

Develop module, 182–183
lens correction/transformation, 

207–211
lesson on, 178
review questions on, 213
shadows and highlights, 195–196
snapshots for variations, 212
texture slider, 202–203
white balance, 191–193

digital notebook, 52–53
digital tablets, 244
Disk Station Manager (DSM), 410
displays. See monitors
distortion, 207
DNG formats

exports in, 376, 381–382
metadata for, 373
overview of, 60

Draft Mode, 351, 356
drag and drop imports, 70
drives, removable. See hard drives
DSLR cameras, 78
dummy Collection Set, 139–140
duplicates

avoiding photo, 72
collection set, 139–140
virtual copies, 210–211

Dynamic range, 259

E
editing. See also advanced editing; 

developing tools
black/white adjustments, 197–200
camera profiles, 187–190
clarity, saturation, vibrance, 

201–204
collection-wide, 26, 132
Compare mode, 108
contrast and exposure, 194–195
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cropping/rotating images, 
184–187

detail, 205–207
Develop module, 32–33, 182–183
exports and, 379–381
external, 13, 18
histogram use for, 198–199
lens correction/transformation, 

207–211
lighting/tonal balance, 35–37
lightroom.adobe.com, 146
Loupe view overlays, 105–106
magnification tools for, 103
mobile, 143, 145, 236
non-destructive, 13, 179, 187
photo shoots, 172
Quick Develop for, 30–32
review questions on, 213
saving snapshots while, 212
shadows and highlights, 195–196
straightening/cropping, 34–35
syncing edits, 265
texture slider, 202–203
using variations, 212
white balance, 191–193
workflow for, 18
workspace layout for, 14, 16

Effects panel, 254–256
eliminating photos, 109
emailing images, 42–43
Enable Address Lookup, 160, 163
Enhance Details, 209
Erase tool, 243
EXIF format, 159, 208
expanding panels, 98–100
exports

archiving, 381–382
further editing of, 379–381
how to create, 376–385
keyword, 151

metadata, 372–373
photo book, 295–296
plug-ins for, 378
presets for, 382–385
review questions on, 386–387
slideshow, 321–322

exposure
AI-based tools for, 234
manual, for panoramas, 257
setting, 194–195
tone mapping and, 259–260

external editing, 13, 18

F
f-stops, 194
face tagging, 13, 160–162
Feather slider, 248
Filename Template Editor, 63
files

accessing cold status, 410
backing up original, 371
common formats, 60
external drive management, 404
formats for backups, 376
in-camera names for, 62
metadata to organize, 159
naming tips, 64
NEF and RAF, 35
organizing photo, 12, 13
overwriting, 377
preview sizing, 6
raw, 35
renaming imported, 62–63
size of backup, 371

Filmstrip
filters, 116–117, 171
function of, 94
lesson images in, 20
module overview, 15–16
navigating controls in, 115

http://lightroom.adobe.com
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photo book, 282
print order in, 342
Quick Collection additions in, 112
rearranging collections in, 134
rearranging images in, 25
resizing, 95–96, 115
showing/hiding, 15, 115–116
thumbnail order in, 117–118
workspace, 14, 115–122

Filmstrip Source Indicator, 115
Filter bar

Attributes filter, 154
custom searches in, 94
finding photos via, 168–170
Metadata filter, 153
viewing imports in, 80

filters
Filmstrip, 116–117
finding/filtering files, 168–171
keyword searches, 152
linear gradient, 237

flagging images
backing up, 370
Filmstrip filtering, 116
how to, 154–156
showing flags, 116
sorting based on, 155
Survey view, 110–111

focus, manual, 257
folders

external drive management, 404
making collections from, 136, 137
moving to NAS device, 409
naming tips, 55, 64, 137
new templates, 320
organizing copied photos in, 

58–59
relinking missing, 405–407
specifying import, 73–74
storage area in, 132

vs. collections, 132
watched, 74–77

formatting files, 60
free space, 394
frequency, 202
frequency separation, 203
Fujifilm cameras, 35, 245

G
G-Technology, 400, 403
gamut, color, 352–353
Genie BigMIND, 400
GPS location tagging, 160, 163–167
Gradient, Linear, 224, 225, 236–239, 

245
grading, color, 188
Grid & Guides panel, 340, 341
Grid view

customizing, 17
Filmstrip and, 15, 115
flagging images in, 154
keyword badge in, 148
Quick Collection additions in, 112
rearranging collections in, 134
rearranging images in, 25
second window, 120
setting options, 82–84
sorting image order in, 117–118
viewing modes, 102

H
Haftel, Josh, 189
hand-tinting, 252
hard drives

backing up, 407
failure of, 370
importing images from, 65–69
medium status projects, 394, 

403–405
moving images to, 404–405
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hardware
digital tablets, 244
free space on, 394
removable drives, 394
requirements for Lightroom, 2
tips for choosing monitors, 355

HDR images
how to make, 259–262
panoramas, 257, 262–264
headless mode, 259, 262

Heal option, 39, 245, 248
Heisler, Gregory, 199, 252, 298–301
Help resources, mobile, 7–9
Henry, Latanya, 272–275
Herrera, Tito, 174–177
HEVC video files, 73
hiding panels

Filmstrip hides, 115–116
groups of panels, 96–98
individual panels, 110

highlights, adjusting, 195–196
Histogram panel, 183
histograms

defined, 198–199
exposure/contrast, 194
limits in, 197
soft proofing, 353

History panel, 32, 33
hot status, 394, 395–400
HSL/Color adjustments, 250–252

I
identity plate, 343–345
image library. See library 

management
Import dialog

box layout, 53–54
camera imports, 55–56
compact mode, 61
expanded mode, 54, 56

Loupe view, 71
Import New Photos, 132
importing photos

Auto Import, 77
automatic, 55
avoiding duplicates, 72
camera imports, 55–65
collections from imports, 184
color shifts and, 188
Copy vs. Add for, 58
hard disk imports, 65–69
hot status project, 395–396
how to, 19–20
lesson on, 50
options for, 12–13, 53–54
Photoshop Elements as source 

for, 75
pre-import evaluations, 71
presets for, 61
review questions on, 85
specific destinations for, 73–74
tethered shooting, 18, 78–80
via drag and drop, 70
video, 73
viewing in work area, 80–84
watched folder, 74–77

impromptu slideshows, 322
ink saving tips, 350
Input sharpening, 205
installation of Lightroom, 2
Intuos tablet, 244
IPTC standards, 158, 159
iterative culling, 396–397
iTunes, 133

J
JPEG

black-and-white images in, 252
camera profiles, 187
detail and, 205
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exporting photos in, 376
format defined, 60
metadata for, 373
white balance and, 191

K
Kerning, 291
keyboard shortcuts

expanding/collapsing panels, 99
second window, 120

keyword sets, 150–151
keyword tagging, 20–21, 148–153

L
labels

backing up, 370
color, 23, 154, 157
Painter tool for, 167–168
rating stars, 23

Lando, Sara, 214–217
landscape profile, 189
layout

custom layouts, 348–351
overlays for, 105–106
photo book, 281–285, 293–294
print template, 340, 347
rearranging print, 342
styles for printing, 335, 336–337

Layout Image feature, 105–106
leading, 291
left panel group

individual panels in, 98
Library module, 94
resizing, 95
showing/hiding, 97

lens corrections, 207–211, 255
light exposure and, 194
panoramas and, 256
spots from dust on, 246

lessons

in Adobe Photoshop Lightroom 
Classic Classroom in a Book, 1

advanced editing, 218
backups and exporting, 366, 

368–369
developing, 178, 180–181
help resources in, 7–9
importing photos, 50
Lightroom overview, 10
online content, 3
photo books, 276, 278–279
printing, 330, 332–333
slideshows, 302, 304–307
web edition, 3
workflow, 392
workspace setup, 90

library management
applying metadata, 158–159
backups, 374–375
collections, 26, 133–142
color coding, 147, 157
face tagging, 160–162
finding/filtering files, 168–171
flags and ratings, 154–156
folders vs. collections, 132
geotagging, 163–167
keyword tagging, 148–153
lesson on, 128, 130–131
library catalogs, 12
mobile editing of, 6
organizational tips, 2, 12, 18, 

20–21
review questions on, 173
syncing collections, 143–146

Library module
Compare view, 107–108
impromptu slideshows, 322
Loupe view, 103–106
overview of, 13, 18
Quick Develop in, 30
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specific folder imports, 73–74
Survey view, 109–110
tethered shooting and, 80
Toolbar, 15
viewing modes, 102
workflow starting point in, 94
workspace layout, 16

light
blocked/blown out areas, 195
exposure and, 194
histograms and, 198
language of, 298
temperature, 191–193

lighting adjustments, 35–37
Lightroom Classic

benefits of, 1
catalog files, 4–6
color management by, 356–357
conceptual cornerstone of, 133
developing and editing, 29–41
digital notebook of, 52–53
hardware requirements, 2
Help resources, 7–9
hierarchy of access in, 401
installing, 2
mobile app, 144–145
mobile editing, 6–7
new features, 1–2, 224
online resources, 9
overview of, 10, 12–13
registering, 3
relinking folders to, 405–407
review questions on, 44–45
sharing images, 42–43
syncing photos from, 143
tethered camera options, 78
workflow for, 18–29

Lightroom.adobe.com site, 146
Linear Gradient

how to use, 236–239

new features, 224, 225
pin adjustment, 245

Live mode, 121
local adjustment tools, 2
localized corrections, 38
location metadata, 13, 163–167
logos, 324
lookup tables (LUTs), 188
loss of data, 370
Loupe view

editing tool overlays, 105–106
flagging images in, 154
info overlay in, 103
overview of, 182
pre-import evaluations, 71
setting options, 82–84
tools for working in, 103–110
video previews, 73

LRC2022CIB folder, 19
luminance, 198, 250, 254
luminance Noise, 206, 207
luminance Range, 229–233

M
machine-learning-based tools, 224
macOS

16-bit printers for, 354
backup drives, 399–400
file/folder management, 404
function keys in, 19, 97
instructions for, 5
Lightroom workspace, 14
partial keyboard, 27
screen modes for, 101
Show Module Picker for, 92

magnification tools, 103–105
managing photos. See library 

management
Mangalick, Sharad, 209
Map module

http://Lightroom.adobe.com
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geotagging in, 163
geotagging without GPS data, 

164–165
overview of, 18
working in, 163–164

margins, 340
marking slideshow images, 23
Mask tool

adding/subtracting with, 227–229
changing colors in, 237
color/luminance range, 229–233
global slider changes, 237
how to use, 206
mask combinations, 233–235
Masking Brush, 203, 242–244, 

245
new features, 2, 224, 225
Select Sky and, 226–227
Select Subject and, 227

Masking Brush, 203, 242–244, 245
McNally, Joe, 397
medium status, 394, 400–407
memory, 214
memory cards

filenames on, 64
formatting, 72
identifying defective, 64
importing photos from, 53, 55–58
recognized as removable disk, 59
removable disk, 56

merging images, 257–259, 260
metadata

adding, 158–159
applying, 68–69
backing up, 370
choosing items of, 84
demosaicing and, 188
exporting, 372–373
image overlays of, 103
keyword tags, 148–154

"painting" on, 167–168
Photoshop Elements, 75
print, 346
review tool of, 94
smart collections from, 142
storage of, 159
tethered shooting with, 78
watched folder, 74, 76

Metadata panel
additions via, 158–159
Customize button, 158
finding photos via, 168, 169
GPS searches in, 165
keyword search in, 21, 153
ratings in, 156
search options, 171

midtones, 201, 202
mirrorless cameras, 369
mobile platforms

AI-based tools for, 236
editing on, 6–7
G-Technology, 403
GPS location tagging, 163
syncing to, 143
viewing synced images on, 

144–145
Module Picker

visibility of, 92
when to use, 18
workspace, 14

modules. See also modules by name
customizing, 90
overview of, 18
panel layout for, 98

monitors
color profiles of, 352
display calibration, 39, 359
tips for choosing, 355
using two, 17, 119–122

monochrome profile, 189
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Monogram Creative Console, 172
moving images

collection-wide, 25
precautions for, 13

multi-batch export, 385
music for slideshows, 317–318

N
naming tips

collection, 137
face tagging, 161
folder, 55, 64
keyword tag, 149
renaming files, 13, 62–63, 64
template, 319

Navigator panel, 103–105, 182
NEF file type, 35
nesting collections, 25
nesting keywords, 150–151
network-attached storage (NAS) 

devices, 395, 408–410
neutral profile, 189
Nikon cameras, 35
noise reduction, 206, 207
non-destructive editing, 13, 179, 187
Normal mode, 120

O
Online resources

advanced editing in, 218
development in, 178
Help online, 8

importing photo resources, 50
library management, 128
Lightroom Classic, 3–4
Lightroom overview, 10
online editing, 146
photo book, 276
workspace setup, 90

operating systems. See also macOS; 
Windows systems

editing variation and, 31
emailing images and, 42
instructions for, 5
RAID devices and, 408
workspace differences, 14

organizing images. See also library 
management

adding metadata, 158–159
avoiding duplicates, 72
color coding, 147, 157
copied image folders, 58–59
face tagging, 160–162
flags and ratings, 153–156
geotagging, 163–167
hard disk imports, 65
keyword tagging, 148–153
Library module, 94
mobile options for, 143–144
Painter tool for, 167–168
syncing collections, 143–146
thumbnail order, 117–118
tools for, 18, 20–21
via collection sets, 141
via collections, 132, 133–142
via digital notebook, 52–53
via metadata, 68–69
via the catalog, 12

orientation, overlay, 185
original image

location of, 12
maintaining aspect ratio of, 34
non-destructive editing of, 13

output options
collections and, 133
modules with, 18
print ready, 354, 358–359

oversaturation, 253
overwriting files, 377
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P
page Grid, 340, 341
Painter tool, 167–168
panels

expanding/collapsing, 98–100
hiding during editing, 187
opening multiple, 152
resizing, 95
role of top panel, 99–100
screen modes and, 101
showing/hiding Filmstrip, 

115–116
showing/hiding groups, 96–98
showing/hiding individual, 100

panoramas
HDR, 262–264
how to make, 256–257
Lightroom merges, 257–259

paper
size for printing, 338
type and sharpening, 354

Parametric Tone Curve, 252
parent folders, 406
PDF photo books, 281, 296
People view, 160–162
perceptual rendering, 357
perspective, 208
photo books

adding page numbers, 284
adding text to, 289–294
assembling images for, 280
backgrounds for, 287–288
changing images, 285
changing layouts, 282–284
exporting, 295–296
lesson on, 276, 278–279
photo cells, 286–287
placing photos, 284–285
review questions on, 297

saving, 294–295
setting up, 281–282

photo shoots
collection sets for, 139, 141
culling images from, 172
memory card tips, 72
tethered, 18, 77, 78–80

photographers, professional
Alan Shapiro, 124–127
Amy Toensing, 326–329
Binuk Varghese, 46–49
Erika Barker, 362–365
Gregory Heisler, 298–301
Joe Conzo, 86–89
Lando, Sara, 214–217
Latanya Henry, 272–275
Maranie Staab, 388–391
Tito Herrera, 174–177

Photoshop Elements catalog, 75
Photoshop formats (PSD)

exports in, 376, 379–381
metadata for, 373
overview of, 60

picked images, 22
Picture Package layout

layout controls, 340
modifying, 340–341
options for, 336–337

presets, 335
Pictures folder, 58
pin, adjustment, 245
plug-ins, export, 378
PNG files, 60
PNG transparency, 106
Point Curve, 252
Portrait profile, 189
post-crop vignetting, 254–256
presets

creating user, 384–385
Develop module, 267–268
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export, 382–383
photo book, 282, 293
print template, 336

previews
enlarging, 107
HDR image, 260
Import dialog, 54
import options for, 66
JPEG, 187
options for, 78
panorama, 257
Print module, 334
restored catalog, 371
screen modes and, 101
Smart Previews, 401–403
thumbnail size, 57

Print Adjustment slider, 357
Print Job panel, 351, 354, 356
Print module

overview of, 18, 329, 334–335
workspace layout, 16

printers
16-bit, 354
color management by, 356
soft-proofing for, 352–353

printing
color management, 354–357
customizing templates, 338–346
layout customization, 348–351
lesson on, 330, 332–333
monitor choice and, 355
output settings, 351, 354
Print module overview, 334–335
resolution for, 285, 336
review questions on, 360–361
saving templates, 347–348
soft proofs for, 352–353
template choice, 338
template overview, 336–337

Process Version 5, 268

processing options, 18
Profile Browser, 190
profiles

camera, 187–190
printer, 352

project management, 394
publishing collections

mobile syncs for, 133
photo book publishing, 295

Q
Quick Collection

adding to/removing from, 
112–114

converting/clearing in, 113–114
function of, 24, 133
showing marker for, 113
target collection of, 114
using option of, 133

Quick Develop
Compare mode, 108
editing with, 29, 30–32

R
Radial Filter tool, 37–39
Radial Gradient

how to use, 240–242
new features, 224, 225
pin adjustment, 245

radius slider, 205
RAF files, 35, 245
RAID drives, 408
range masking, 224, 225, 229–233
ranking images, 23, 154–156
rating system

backing up, 370
creating a, 154–156
finding photos via, 169

raw formats
camera profiles for, 188
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color in, 209
contrast comparisons and, 195
defined, 60
Fujifilm, 245
HDR image, 259–260, 261
metadata export and, 373
Nikon vs. Fujifilm, 35
panorama, 257
white balance and, 191, 192

realism, 261
rearranging images, 25
recognition, facial, 160–162
Reference view, 182
registering Lightroom Classic, 3
rejected images

flagging, 22, 110–111
iterative culling for, 396–397

relative rendering, 357
relinking folders, 405–407
renaming files, 13, 62–63
rendering, 353, 357
resizing

Brush tool, 243
filmstrip, 115–116
panels, 95
photo cells, 340
prints and, 338

resolution
export presets, 385
print-ready, 285, 336

review tools, 20–21, 94
Rotate to Fit option, 344
rotating images, 184–187
ruler units, 340
rulers, 341

S
saturation, 201–204
Saved Locations panel, 166
saving work

photo books, 294–295
print output settings, 358–359
print templates, 347–348

slideshows, 315–316, 318–320
screen modes, 101
Scrubby Zoom, 104
searches

color label, 157
keyword, 152–154
Filmstrip, 171
Filter bar, 168–170

second window, 17, 119–120
security issues, with metadata, 68
Select Catalog dialog, 6
selecting images, 107, 122
Select Sky, 224
Select Subject, 224
selecting components/images

additions and subtractions, 
227–229

Compare view for, 107–108
flagging for, 110–111
highlighted border for, 24
iterative culling for, 396–397
mask tool for, 224
Select Sky/Select Subject, 224, 

225–227
Survey view for, 109–110

sensor spots, 245–247
settings, backing up, 367
shadows, adjusting, 195–196
Shapiro, Alan, 124–127
sharing work. See also exports, 

42–43
sharpening, 207
shortcuts, 99
Show Parent, 406–407
showing panels

Filmstrip for, 115–116
groups of panels, 96–98
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individual panels, 100
side-by-side comparisons, 27–28

single image layouts
layout controls, 340
modifying, 340–341
options for, 336–337
presets, 335

skin texture, 203
Slideshow module

how to use, 307–308
overview of, 18
settings in, 22
tools in, 303
workspace layout, 16

slideshows
adding to/removing from, 316
author's tips on, 323–324
customizing templates, 309–313, 

318–320
exporting, 321–322
impromptu, 322
intro slides, 323
lesson on, 302, 304–307
review questions on, 325

saving, 315–316
Slideshow module how to, 307–308

sound and motion in, 317–318
text in, 312–314

smart collections, 133, 142, 410–411
Smart Previews

built during imports, 78
cold status project, 409
how to create, 401–403
mobile syncs of, 6
relinking missing folders, 405
vs. smart collections, 410–411

snapshots for variations, 212
soft proofing, 352–353
Solo Mode, 17
Sort Direction icon, 117

source indicator, 115, 120
space, color, 352–353
spherical panoramas, 257
Spot Removal tool, 39–41, 245–250
spots, sensor, 245–247
SSD drives, 404
Staab, Maranie, 388–391
standard collections, 24
storage

collections for, 133
folders for, 132
imports from external, 53–54, 56, 

65–69
metadata, 159
NAS devices, 395
size of backups, 371

straightening images, 34–35, 186
Stroke Border, 342
subfolders, 406
subjects

linear gradient use on, 238
radial gradient to highlight, 

240–242
selecting, 224, 225–227
tools for masking, 224

Survey view
image classification in, 28
image comparison in, 28–29
narrowing selections with, 

109–110
syncing

changes to save time, 264–266
collections, 143–146
mobile editing, 6–7
relinking missing folders, 405–407
slides to music, 318

Synology, 408

T
tablets, 244
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tagging images
color labels, 23, 157
face tagging, 160–162
geotagging, 163–167
keyword tagging, 20–21, 148–153
Toolbar button for, 102

target collections, 114
Targeted Adjustment tool, 250–252
temperature, color, 191–193, 207
temperature slider, 193
Template Browser, 334, 335, 

336–337
templates

editing text, 314
filename, 63
metadata, 159
modifying/organizing, 319–320
photo book, 282–283, 284, 286
print, 336–348, 359
slideshow, 309–313, 318–320, 323

tethered shooting
importing images and, 77, 78–80
overlays for, 105

text
identity plate, 343
photo book, 289–294
slideshow, 312–314, 323–324

template editor, 314
Text filter

finding photos via, 168–169
keyword search in, 21

Text Template Editor, 314, 346
Texture slider, 201, 202–203
thumbnails

badges for, 133, 148
changing order of, 117–118
changing size of, 57, 152
color shifts in, 188
customizing video, 73
Filmstrip, 15

rating stars in, 23
Thunderbolt 3 drives, 400, 404
TIFF

exports in, 376, 379–381
metadata for, 159, 373
overview of, 60

tilt, image, 208
Time Machine, 399–400
tint, 192, 193, 252
tips

module-specific, 7–8, 14
re-activating, 14

Toensing, Amy, 326–329
Toggle Zoom View, 103–104
toggling screen modes, 101
tokens, 63
tone mapping, 259–260, 261

Print Adjustment slider, 357
tonal balance, 30, 35–37
tonal range, 197, 198
tone curve changes, 250, 251–252
wheel, 253–254

Tone Curve panel, 251–252
Toolbar

function of, 15
increasing width of, 82
order of, 102
showing/hiding, 81, 184
viewing modes, 102

tools. See also specific tool by name
AI-based, 224
module-specific, 16
showing/hiding, 17
viewing order of, 102
working with light via, 298

tracking changes, 12–13, 291
transformations, 207–211
troubleshooting, 7–9
Type panel, 291
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U
Undo, 109
user presets, 384–385

V
Varghese, Binuk, 46–49
variations, 210–212
version updates, 1
vibrance, 201–204
video files

color lookup tables for, 188
importing, 73
overview of, 60
print lesson, 357
slideshows with, 317

view options
Grid view, 24
hiding menus, 30
switching views, 102

vignetting, 207, 254–256
virtual copies, 210–211, 212
vivid profile, 189

W
Wacom Intuos tablet, 244
warm color, 193
watched folders, 74–77
Web module, 16, 18
Wendt, Max, 203
white balance, 31, 32, 191–193
White Balance Selector tool, 193
white point, 192
whites, adjusting, 197–200
Windows systems

backup drives, 399–400
instructions for, 5
screen modes for, 101
Show Module Picker for, 92
Windows Explorer, 404

workflow
collections for, 184
copied image location, 58
hot, medium, and cold strategy, 

394–411
lesson on, 392
memory card staggering, 72
Monogram Creative Console for, 

172
overview of, 10, 18–29
review questions on, 412–413
Smart Previews, 78
streamlining, 2
tips for slideshow, 323

workspace
customizing, 90, 91, 95–100
Filmstrip, 115–122
flagging/deleting images, 110–111
Import dialog, 54
lesson on, 90
Loupe view, 103–110
overview of, 14–17
Quick Collection, 112–114
review questions on, 123
switching views, 102
tips for getting started, 92–93
toggling screen modes, 101
viewing imports in, 80–84
viewing/managing images, 94

X
XMP metadata, 148, 159, 373

Z
zoom controls

Loupe view, 103–105
photo cell, 286
slideshow, 317–318
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